




























































































































































































































































































































































































































































































































Filters 

v Tips 

• To create a pin spot, choose Spotlight 
from the Light Type pop-up menu, 
move the Intensity slider to about 80, 
move the Focus slider to about 30, 
and drag the side points of the ell ipse 
inward. Move the whole ellipse by 
dragging its center point to cast light 

Figure 101g. The spotlight Figure 101h. The spotlight on a particular area of the picture. 
ellipse with the Exposure ellipse with the Exposure • If the background of a picture has 
Property set to Over. Property set to Under. been darkened too much from a 

previous application of the Lighting 
Effects filter, apply the filter again 
to add another light to shine into the 
dark area and recover some detail. 
Move the Exposure Properties and 
Ambience Properties sliders a little to 
the right. 

• To see the picture in the Preview box .. -without the ellipses, drag the light ua 
::r 

bulb icon just in side the bottom edge .. -Figure 101i. The spotlight Figure 101j. The spotlight of the Preview box. Delete the extra :1 ua 
ellipse with a Positive ellipse with a Negative light when you're finished. Ill Ambience Property. Ambience Property. • To delete a light source ellipse, d rag = CD 

its center point over the Trash icon. " • Check the Light Type/On box to pre-
: ... 

view the lighting effects in the Preview --box. ' • To duplicate a light source ell ipse, 
.. 

hold down Option and drag its center 
point. 

Figure 101k. The default • The last used settings of the Lighting 
Omni light is round. The effect Effects filter will remain in the d ialog 
is like shining a flashlight box until you change the settings or 
perpendicular to the picture. quit Photoshop. To restore the Defau lt 

settings, choose a different style from 
the Style pop-up menu, then choose 
Default from the same menu. 

• To add your own Lighting Effects 
settings to the Style pop-up menu, 
click Save before clicking OK. 

• Click Delete to remove the currently 
Figure 1011. Drag a new light selected style from the pop-up menu. 
source onto the preview box. 
A new ellipse will appear • Press Tab to select various light 
where the mouse is released. sources. 
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Chapter 20 

Our custom lighting effect 

To produce Figure 104, we chose RGB 
Color mode, chose a target layer (the fig­
ures), and chose Lighting Effects from the 
Render submenu under the Filter menu. 

In the Lighting Effects dialog box, we: 

• Chose Spotlight from the Light Type 

• • • 
• 

• 
• 
• 

• 

pop-up menu. 

Set the Intensity halfway toward Full. 

Set the Focus toward Wide . 

Dragged the side points of the ellipse 
inward to make it narrower. 

Dragged the centerpoint of the ellipse 
to cast the light over the face on the 
left in the picture. 

Set the Exposure Property slightly 
toward Over to brighten the light 
source. 

Moved the Ambience Property slider 
to 2 to darken the background of 
the picture . 

Dragged the endpoint of the Radius 
slightly inward to focus the beam 
of light more intensely on the face. 

When we were satisfied with the 
light source on one face, we Option­
dragged the centerpoint of the ellipse 
to duplicate the light, and move the 
duplicate light over the face on the 
right. 

• To create a subtle backlight, we 
dragged the light bulb icon into the 
Preview area to create another light 
source, rota ted the ellipse sideways, 
and set the Intensity to be less Full 
than the other lights. We left the 
Focus setting between Narrow and 
Wide and left the Properties setting 
a lone. 

V' Tip 
• Apply Lighting Effects to the Back­

ground layer fi rst, then to successive 
layers above it. 
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Figure 102. The original RGB picture. 

Figure 103. The three ellipses used to 
produce Figure 1 04. 

Figure 104. The picture after applying the 
Lighting Effects filter with our own settings. 



Note: If you convert a multi-layer 
document to Indexed Color mode, 
the layers will be flattened. To 
preserve layers when converting a 
picture to Indexed Color mode, 
use our technique for saving a 
copy of a layer in a separate docu­
ment (see page 153). 
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! 
Bitmap 
Grayscale 
Duo tone 

..-'RGB Color 
CMYK Co lor 
Lab Co lor 
Multichannel 

Color Table ... 

CMYK Preuiew 
Gamut Warning 

Figure 1. Choose Indexed 
Color from the Mode menu. 

I ndeHe~ Color 

r- Resolution 
0 3 blts/ piHel 
0 4 blts/ piHel 
0 5 blts / piHCI 
0 6 blts / piHel 
0 1 blts/ piHel 
® 8 blts / piHel 

0 Olher: c::J colors 

OD 
(Cancel ) 

,Polelte- ,- Oither -

O IHotl O None 
O SySiem 0 Pettern 
@ftdopllue ® Dirtusion 
Q Custom ... 
0 Preulous 

Figure 2. Click Resolution, Palette, and Dither 
options in the Indexed Color dialog box. 

INDEXED COLOR 21 
SOME MULTIMEDIA and video 

programs and some computer sys­
tems will not import a Photoshop 

picture containing more than 256 colors 
(8-bit color). By converting a picture to 
Indexed Color mode, the number of col­
ors in its color table can be reduced. This 
chapter covers conversion to Indexed 
Color mode as well as some "arty" 
effects that can be produced by editing 
the color table of an Indexed Color pic­
ture. 

To convert a picture to Indexed 
Color mode: 
1. If the picture is not in RGB Color 

mode, choose RGB Color from the 
Mode menu . 

2. Choose Indexed Color from the 
Mode menu (Figure 1). 

3. Click a Resolution to specify the 
number of colors in the table (Figure 
2). If you click 4 bits/pixel, the table 
will contain 16 colors. If you click 
8 bits/pixel, the table will contain 
256 colors. The fewer bits/pixel, the 
more dithered the picture will be. 

4. Click a Palette. If the RGB Color 
picture contains 256 or fewer colors, 
you can click Exact. 
or 
Click Adaptive for the best color 
substitution. 
or 
Click System if you are going to 
export the file to an application that 
only accepts the Macintosh default 
palette. 

5. Click None, Pattern, or Diffusion 
Dither. Diffusion may produce the 
closest color substitution. 

6. Click OK or press Return. 
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Chapter 21 

To edit an Indexed Color table: 
1. Choose Color Table from the Mode 

menu (Figure 3). The Color Table will 
display all the picture's colors. 

2. Click on a color to be replaced 
(Figure 4). 
or 
Drag across a series of colors. 

3. Move the slider up or down on the 
vertical bar to choose a hue, then click 
a varia tion of that hue in the large rec­
tangle (Figure 5). 

4. Click OK to exit the Color Picker. 

5. Click OK or press Return. 

V' Tip 
t» • In Indexed color mode, the Pencil, -.a Airbrush, and Paintbrush tools pro-
' duce only opaque strokes. For those 
., tools, leave the Opacity slider on the 
~ Options palette at 100%. Dissolve is 
u the only tool mode that will produce 
"'I a different stroke. 

= .,. 
1: -1: 
Ill 
• :; 
Ill 

Figure 4. Click a color in the Color Table dialog box, or 

Bitmap 
Grayscale 
Duotone 

./I ndeHed Color 
RGB Color 
CMYK Color 
Lab Color 
Multichannel 

Color Table ... 

CMYK PreUJew 
Gamut Warning 

Figure 3. Choose Color 
Table from the Mode menu. 

Color Picker 

100 
I Contel ] 

I Custom) 

drag across a series of colors. Figure 5. Choose a replacement color in the Color Picker. 
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00 
I Cancel I 

( Load ... ) 

~ 

Figure 6a. Choose Spectrum from the Table pop-up 
menu in the Color Table. 

~ 
[ Soue ... ) 

Figure 6b. The Spectrum Color Table. 

Cokar Pltt er 

Figure 7. Choose a first and last color from the Color Picker. 

Indexed Color 

We've gotten beautiful effects and 
atrocious effects using the Spectrum 
Color Table. 

To choose the Spectrum table: 
1. Choose Color Table from the Mode 

menu (Figure 3). 

2. Choose Spectrum from the Table 
pop-up menu (Figures 6a-b and 
Gallery 6a-b). 

3. Click OK or press Return. 

V" Tip 
• You can convert a Grayscale picture 

directly to Indexed Color mode, and 
then modify its Color Table. 

For the best results, choose a warm 
"first color" and a cool " last color," or 
vice versa, for steps 3 and 5 below. 

To reduce an Indexed Color 
table to two colors and the 
shades between them: 
1. Choose Color Table from the Mode 

menu (Figure 3 ). 

2. Drag across the Color Table from 
the first swatch in the upper left cor­
ner to the last swatch in the lower 
r ight corner. 

3. Choose a "first color" from the Color 
Picker: move the slider up or down on 
the vertical bar to choose a hue, then 
click a variation of that hue in the 
large rectangle (Figure 7). 

4. Click OK. 

5. Choose a " last color " from the Color 
Picker. 

6. Click OK to exit the Color Picker. 

7. Click OK or press Return. 
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Chapter 21 

You can create a painterly effect by gener­
ating an Indexed Color picture from 
an RGB Color picture, then pasting the 
Index Color picture back into the RGB 
Color picture. 

To recolor an RGB picture: 
1. If the picture is not in RGB mode, 

choose RGB Color from the Mode 
menu. 

2. Follow the steps on page 237 to 
convert the picture to Indexed Color 
mode. 

3. Choose Color Table from the Mode 
menu (Figure 3) . 

4. In the Color Table dialog box, 
choose Spectrum from the Table 
pop-up menu (Figure 8). 

5. Click OK or press Return. 

6. Choose All from the Select menu. 

7. Choose Copy from the Edit menu . 

8. Choose Revert from the File menu. 

9. Click Revert to restore the picture 
to RGB Color mode (Figure 9). 

= 10. Choose Paste Layer from the Edit 

0 menu, then click OK, to paste the 
v Indexed color picture onto a new 
:I layer. 

n. Double-dick the new layer name 
(Figure 10). 

12. Choose from the Mode pop-up menu 
(Figure 11). Dissolve, Soft Light, 
Difference and Color produce inter­
esting results. 

Steps 13 and 14 are optional. 
13. Change the Opacity percentage. 

14. Move the black Underlying slider 
to the right to restore shadows from 
the underlying layer. 
and/or 
Move the white Underlying slider to 
the left to restore highlights from the 
underlying layer. 

15. Click OK or press Return (Gallery 
6c-d). 

240 

DO 
( Cancel) 

~ 
( Saue ... ) 

Figure 8. Choose Spectrum from the Table pop-up 
menu in the Color Table dialog box. 

£ Reuert to the preulously saued uerslon of 
~ .. nowcrs ps 2.5"? 

Figure 9. Click Revert to revert to RGB Color mode. 

Figure 10. Double-click the new layer name 
on the Layers palette. 

L.!!i.er~lon• 

Name: jteyer 11 I DO 
Opacity: [§] ~~ J~~~:~~e ( Cancel ) 

0 Group With Pr ® Preulew 

1 Blend If: ·-~ 
MuiUply 
Sl reen 

This Loyer: 0 Ouert!.!! 

Underlying: 0 
Herd Light 

Oorken 
lighten 
Difference 

Hue 
Solure11on 
Color 
Lumlnosii iJ 

Figure 11. Choose a Mode in the Layers Options 
dialog box and/or move the Underlying sliders. To 
restore midtonEs, Option-drag to split the triangle slider. 



RESOLUTION OF OUTPUT DEVICES 

Hewlett Packard Laser jet 300or 600 dpi 
Apple Laser Writer 300 or 600 dpi 

IRIS Smartjet 300 dpi 

3M Rainbow 300 dpi 

QMS Colorscript 300 dpi 
Canon Color Laser/Fiery 400 dpi 
Linotronic imagesetter 1,200-3,386 dpi 

Press and hold on the Sizes bar 
to display the print preview. 

I 
451K ¢ 

lolidth: 432 pixels <6 inches) 
Height: 288 pixels <4 inches) 

Channels: 3 (RGB Color> 
Resolution: 72 pixels/inch 

Figure 1. Hold down Option and press and 
hold on the Sizes bar to display file information. 

PRINTING 

A 
PICTURE CAN BE printed from 
Photoshop to a laser printer, to a 
color printer (thermal wax, dye 

sublimation, etc.), or to an imagesetter. 
A Photoshop picture can also be import­
ed into and printed from another applica­
tion, such as QuarkXPress. 
Printer settings are chosen in the Print 
dialog box and Page Setup dialog box, 
opened from the File menu. The follow­
ing pages contain output tips, informa­
tion about file compression, instructions 
for outputting to various types of print­
ers, and instructions for creating duo­
tones. Figure 14 on page 248 identifies 
Page Setup dialog box options. 
Press and hold on the Sizes bar in the 
lower left corner of the document win­
dow to display a thumbnail preview of 
the image in relationship to the paper 
size and other specifications chosen in 
the Page Setup dialog box (Figure 1). 
Note: Many of the terms used in this 
chapter are defined in Appendix A: 
Glossary, including CMYK, Color separa­
tion, DCS, DPI, Dye sublimation, EPS, 
Film negative, Halftone screen, Imagesetter, 
Ink jet, ]PEG compression, Lab, LPI, 
Moires, PostScript, Process color, 
Registration marks, Resolution, Screen 
angles, Screen frequency, Thermal wax, 
and TIFF. 
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Chapter 22 

Output tips 
Before outputting your file at a service 
bureau, ask your print shop or publisher if 
they have any specifications for the paper 
or film output you give them. Make sure 
the picture is saved at the appropriate res­
olution for the output device. Also ask 
what halftone screen frequency (lpi) the 
print shop will use and output your file at 
that frequency. 
You might also ask your service bureau if 
you should save your file with special set­
tings for a particular printer, such as in a 
particular picture mode or resolution. Let 
the service bureau calculate the halftone 
screen angle settings. (See also "Potential 
Gray Levels at various output resolutions and 
screen frequencies" on page 3 7) 

File Compression 
To reduce the storage size of a picture, use 
a compression program, such as Disk­
Doubler or Stufflt. Compression using this 
kind of software is non-lossy, which means 
no information is lost during the compres­
sion process. 

If you do not have compression software, 
choose Save As from the File menu, choose 
TIFF from the File Format pop-up menu, 
and check the LZW Compression box in 
the TIFF Options dialog box. If you want 
to save any alpha channels as part of the 
file, check the Save Alpha Channels box. 
LZW compression is also non-lossy. Some 
applications will not import an LZW 
TIFF; other applications will import an 
LZW TIFF only if it doesn't contain an 
alpha channel. 

We don't recommend saving pictures in 
the JPEG file format or using the 
Compress EPS/JPEG command for pic­
tures that will be printed. JPEG compres­
sion is lossy - more information is lost 
each time the Compress EPS/JPEG com­
mand is applied. The loss of data may not 
be noticeable on screen, but it will be very 
noticeable on high resolution output. 
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QUESTIONS TO ASK YOUR 
PRINT SHOP ABOUT COLOR SEPARATIONS 

Yes, you can get good color separa­
tions out of Photoshop, but color sep­
arating is an art. As a starting point, 
ask your print shop these questions so 
you '11 be able to choose the correct 
scan resolution and settings in the 
Printer Inks Setup and Separation 
Setup dialog boxes: 

What lines per inch setting is going to 
be used on the press for my job? This 
will help you choose the appropriate 
scanning resolution. 

What is the dot gain for my paper 
stock choice on that press? Allowances 
for dot gain can be made using the 
Printer Inks Setup dialog box. 

Which printing method will be used 
on press- UCR or GCR? GCR pro­
duces better color printing and is the 
default choice in the Separations 
Setup box. (GCR stands for Gray 
Component Replacement, UCR 
stands for Undercover Removal.) 

What is the total ink limit and the 
Black ink limit for the press? These 
values can also be adjusted in the 
Separations Setup box. 

Note: Change the dot gain, GCR or 
UCR method, and ink limits before 
you convert your picture from RGB 
Color mode to CMYK Color mode. If 
you modify any of these values after 
conversion, you must convert the pic­
ture back to RGB Color mode, adjust 
the values, then reconvert to CMYK 
Color mode. 



To print to a black·ancl·whlte 
laserwrlter: 
1. Choose Print from the File menu. 

or 
Hold down Command (3€) and 
press "P". 

2. Click Color/Grayscale (Figures 2-4). 

3. Click Printer. 

4. If the picture is in CMYK Color 
mode, make sure the Print Separa­
tions box is unchecked to print a 
composite image. 

5. Click Binary. 

6. Click Print or press Return. 

V Tips 

Printing 

• If your picture does not print and 
you have a print spooler, try printing 
with ASCII Encoding selected. ASCII 
printing takes longer. 

• To print only a portion of a picture, 
select the area with the Marquee 
tool and check the Print Selected 
Area box in the Print dialog box. 

LaserWriter "Pierre 2f" 1.1.2 I[ Print J 
Copies:ll!!jl Pages: ®All 0 From: D To: D ( Cancel ] 

Couer Page: ® No 0 First Page 0 Last Page 

Paper Source: ® Paper Cassette 0 Manual Feed 

Print: 0 Black & White ® Color/Grayscale 

Destination: ®Printer 0 PostScript® File 

D Print Selected Area Encoding: 0 ASCII ®Binary OJPEG 

Figure 2. In the Print dialog box, click 
Color/Grayscale, and click Binary. This 
illustration shows the Print dialog box 
for a picture in RGB Color mode. For a 
picture in CMYK Color mode, leave the 
Print Separations box unchecked to 
print the composite picture. 

Print In: 0 Gray @ RGB 0 CMYK 

Printer: "LW H6llway 600" a.u 

Copies: HtlU Pages: ® Rll 0 From:D To: D 
Layout:~ ,..Paper Source .... ____ -·--·-"""! rOestlnatlon.., 

! ®All 0 First from: I Cassette •II I ®Printer I 
Rl'muining from: I Ca~sette ...-!! I 0 File ' 

_________ __j !..-----·---·-· 

[I Print H 
( Cancel I 

(Options I 
Help 

D Print 'ielerted Rrea Encoding: 0 ASCII ®Binary 0 JPEG 
Print In: 0 Gray @ RGB 0 CMYK 

Figure 3. The Print dialog box 
when using the LaserWriter 8 
driver. Leave the Print In but· 
tons as is to print a composite 
picture, click Binary, then click 
Options. This illustration shows 
the Print dialog box for a picture 

!,!;;;;;;;;======================:::::.! inRGB mode. 

Print Options a.1.1 

Couer Page: ® None 0 Before 0 Rfter Document 

Print:l Color/Gragscale .,..I 
PostScript'" Errors:l Summarize on Screen .... 1 

([ OK J] 
( Cancel ] 

( Help ) 

Figure 4. In the 
LaserWriter 8 Print 
Options dialog box, 
choose Color/Grayscale 
from the Print pop-up 

l!;;;;;;;;===========================!l menu, then click OK. 
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Chapter 22 

To print to an Apple LaserWriter 
with Photogracle: 
1. Choose Page Setup from the File 

menu (Figure 5). 

2. Click Screen (Figures 6-7). 

3. Click Use Printer's Default Screens, 
then click OK. 

4. Click OK or press Return. 

5. Choose Print from the File menu 
(Figure 5). 
or 
Hold down Command (~) and 
press " P". 

6. Click Color/Grayscale. 

7. Click Printer. 

8. Make sure the Print Separations box 
is unchecked . 

OON 
00 0 

Close OO W 
Sau e 11€S 
SoueRs •. • 
Soue o Copy ... 
Reuert 

Acquire 
EHport 

File Info .•. 

Page Setup ... 
Print ... OOP 

Preferences ., 

Quit OOQ 

9. Click Print or press Return. 
Figure 5. Choose Page Setup 
from the File menu. 

Click Screen. -
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leserWrlter Page Setup 1.1 2 

Paper: ® us Letter 0 R4letter 
0 US Legal 0 B5 Letter 0 I Tabloid •I 
Reduce or lifii0i11. 
Enlarge: ~ 

Orientation 

-~ 

Printer Effects: 
181 Font Substitution? 
181 TeHt Smoothing? 
181 Graphics Smoothing? 
181 f oster Bitmap Printing? 

~ 
( Cancel J 

I Options I 

0 ReglstraUon Marks 0 Negallue 
I Transfer ... I I Bleed... I 0 corner Crop Marks 0 Emulsion Down 

Mil§§: ( Border ... ) 0 Calibration Bars 0 Labels 

I Background ... I 0 Caption 0 Cenler Crop Marks 0 Interpolation 

Figure 6. Click Screen in the Page Setup dialog box. 

US letter ... ) 

Layout :~ 

Reduce or~~ 
Cnlarge: ~ 

Orie ntation: grj} ~ 

~ OK )J 

~ 

Figure 7. The LaserWriter 8 Page Setup dialog box. Don't change the 
default Paper. Layout, Reduce and Oriemation settings. Read about other 
Page Setup options on page 248. 



Lou!rWrller Pose setup ,. OD Paper. ® US letter 0 M Letter 
Q US Legal 0 85 Le tter 0 .,....Tabloid ~ 
~~~~~~:0'~1 Prln 

A3lablold 

~ £nuetope- Center Fed 
!!li Fo £nuelope - Edge Fed 

Orienta lion !!li Te Lase ..-W..-iler II 05 

-~ 
!!li G• '' 
!ill • ColorMaller• A Ouenize 

ColorM1uter• A4 
I \treens ... II Bo.Oe• ... I 0 Lo ColorMoster• A4 Ouenlze 

I Trant fer ... II Copllon ... l ~ ~ ColorMaster• 8 ~"" 
ColorMaster• 0 Ouerslze n 

! Background ... ) OR ColorMaster• R3 

Figure 8. Choose the correct color printer option from the pop­
up menu in the Page Setup dialog box. 

Loserwrtter "Pierre 2t" 1, , (E) 
Coplet:{g] Pages:® All 0 From: D To: D 1 Cancel 1 

Couer Page: ®No 0 rlrst Page 0 Last Poge 

Paper Source:® Paper Cauette 0 Manual reed 

Print: 0 BIGck D' White ®Color/ Grayscale 
Oesllnotlon: ® Printer Q PostScrip t& rile 

OPrint St-Jectcd ni('Q 

0 Print hparallons 
[ntoding: 0 ASCII @Binary 

Figure 9. In the Print dialog box, click Co/or/Grayscale and 
click Binary. This illustrations shows the Print dialog box for a 
CMYKfile. 

For each ink color you can enter Frequency and Angle 
values and choose a Shape. 

Halftone Stre-ens 

0 Use Printer's 0 foult Streens 

r I nk: Cyon 31 1 ~ -------., 

Frequency: ~ I lines/ Inch ... 1 

Angle: ~ degrees 

Shope: I Dlnmond •I 

D Use Accurote Screens 
[8J use Seme Shope for All Inks: 

Figure 10. The Halftone Screens dialog box. 

~ 

~ 
~ 

Printing 

To print to a PostScript color 
printer: 
1. To print to a PostScript Level 1 

printer, choose CMYK Color from 
the Mode menu. CMYK color will be 
simulated on the screen (Figure 11). 
or 
To print to a PostScript Level 2 
primer, choose Lab Color from the 
Mode menu. 

2. Choose Page Setup from the File menu. 

3. Choose the correct color printer 
option from the pop-up menu 
(Figure 8). 

4. Click OK or press Return. 

5. Choose Print from the File menu 
(or hold down Command (~) and 
press "P"). 

6. Click Color/Grayscale (Figure 9). 

7. Click Binary. 

8. Click Print or press Return. 

V Tips 
• For a PostScript Level 1 printer, 

check the Use Same Shape for All 
Inks box. For a PostScript Level 2 
printer, check the Use Accurate 
Screens box, and don 't change the 
ink angles (Figure 10). 

• If the printout is too dark, lighten 
the picture using the Levels dialog 
box, opened from the Adjust pop-up 
menu under the Image menu. Move 
the gray Input slider a little to the left 
and the black Output slider a little to 
the right. 
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Chapter 22 

To prepare a file for an IRIS 
printer, a clye sublimation 
printer or an imageseHer: 
1. To print on a PostScript Level 1 

printer, choose CMYK Color from 
the Mode menu (Figure 11). 
or 
To print on a PostScript Level 2 print­
er, choose Page Setup from the File 
menu (Figure 12), click Screen, and 
check the Use Accurate Screens box. 
Ask your service bureau whether the 
file should be in CMYK Color or Lab 
Color mode. 

2. Choose Save As from the File menu. 

3. Choose EPS from the File Format 
pop-up menu. 

4. Choose Preview: Macintosh 
(8-bits/pixel) (Figure 13). 

5. Choose Encoding: Binary. 

6. Click OK or press Return. 

V Tips 
• Ask your service bureau to recom­

mend a picture resolution for the 
color printer or imagesetter you plan 
to use. (See also "Resolution" on page 
35) 

• To superimpose type over a picture, 
import the Photoshop picture into a 
document in an illustration or page 
layout program, add the type, and 
output the file from that program. 
Your service bureau will need the orig­
inal Photoshop file to output the file. 

• If your picture is wider than it is tall, 
ask your service bureau if it will print 
more quickly if you rotate it first 
using Photoshop's Rotate command. 
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Figure 11. Choose 
CMYK Color from 

the Mode menu. 

Figure 12. Choose 
Page Setup from 

the File menu. 

II' 

Bitmap 
Grayscale 
Duo tone 
lndeHed Color ... 

./RGB Color 

Lab Color 
Multlchonnel 

Color Table ... 
.........:...... 

CMYK Preuiew 
Gomut Warning 

New .. . 
Open .. . 
Place .. . 

Close 

S&N 
8&0 

SaL•e :31?S 
Saue As ... 
Saue a Copy ... 
Ret•ert 

Acquire ., 
EHport ., 

File Info ••• 

Page Setup ... 
Print... XP 

Preferences ., 

Quit 380 

Preulew: I Macintosh IB blts/piHell •I 
Encoding: lL_;;;,Bin;;,;;a;.~~~ru ____ .......;...J..,.I 

llellltl' PIHP!i 

0 Include Halftone Screen 

0 Include Transfer Function 

Figure 13. In the EPS Format dialog box, choose Preview: 
Macintosh (8-bitslpixe/) and Binary Encoding. 



---------------------------------------------------------P_ri_n __ fin~ 

....------- TO PRINT VIA QUARKXPRESS ------., 

To color separate a Photoshop picture from QuarkXPress, first 
convert it to CMYK Color mode. Ask your prepress service 
bureau whether to save it in the TIFF or EPS file format. For 
example, to color separate a picture on a Scitex-Dolev image­
setter, save it as an EPS with the Desktop Color Separation 
(DCS) option Off. Instructions for saving a file as an EPS are on 
page 52. Instructions for saving a file as a TIFF are on page 53. 

Leave the Include Halftone Screens and Include Transfer 
Functions boxes unchecked. Your prepress service bureau will 
choose the proper settings. 

Printing technology is developing rapidly. Your service bureau 
is in the best position to recommend appropriate file formats 
for color separation on its printers. 

TO OUTPUT VIA A FILM RECORDER 

Color transparencies, also called chromes, are widely used as a 
source for pictures in the publishing industry. A Photoshop file 
can be output to a film recorder to produce a chrome. Though 
the output settings for each film recorder may vary, to output to 
any film recorder, the height and width dimensions of the pic­
ture file must conform to the pixel count the film recorder 
requires for each line it images. If the picture originates as a 
scan, the pixel count should be taken into consideration when 
setting the scan's resolution, dimensions, and file storage size. 

For example, let's say you need to produce a 4 x 5-inch chrome 
on a Solitaire film recorder. Your service bureau advises you 
that to output on the Solitaire, the 5-inch side of your picture 
should measure 2000 pixels and the file storage size should be 
at least 10 megabytes. (Other film recorders may require higher 
resolutions.) Choose New from the File menu, enter 2000 for 
the Width (in pixels) and 4 inches for the Height, enter a 
Resolution value to produce an Image Size of at least 1OMB, 
and choose RGB Color Mode. Click OK to produce the picture 
entirely within Photoshop, or note the resolution and dimen­
sions, and ask your service bureau to match those values when 
it scans your picture. 

If the picture is smaller than 4 x 5 inches and you would like a 
colored background around it, click Background in the Page 
Setup dialog box, then choose the color your service bureau 
recommends. 
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A picture will print faster with Portrait Orientation 
(left) than with Landscape Orientation (right). If 
your picture is wider than it is tall, choose Rotate 
90° CW from the Image menu. Then you can print it 
with the Portrait Orientation. 

Leserwrtter Pose setup 7.1.2 ~ Peper: ®US Letter 0 A4Letter 
ol Tabloid •I I Cenc:el) 0 us Legel 0BS Letter 

Reduce or~% 
Enlarge: ~ 

Orientation 

-~ Mill§§! Border •.. 

I Trensfer ••• II Bleed ••• 

- laecleground ••• ) 0Caption 

To print a black border 
around an image, click 
Border and specify a width. 

To print a colored background 
around an image, click 
Background, then choose a color. 

Printer Effects: [Options) 
181 Font Substitution? 
181 TeHt Smoothing? 
181 Graphics Smoothing? 
181 Fester Bitmap Printing? 

rfJ Callbretion Bars OLebels 
I 0 Registretlon Merles 0 Negative -

0 Comer Crop Maries 0 Emulsion Down 
OCenter Crop Maries 0 Interpolation 

Check the Registration Marks 
box to create marks the print shop 
will use to align color separations. 

Check the Calibration Bars box to 
create a Grayscale and/or color cali­
bration strip outside the image area. 

Figure 14. The Page Setup dialog box. 

=r 
-

Check the Labels box 
to print the document's 
title and channel names. 

Check v;ith your print 
shop before choosing 
either film option. 

Check the Interpolation 
box to reduce jaggies 
when outputting to a 
PostScript Level 2 printer. 
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Figure 15. A printout showing Page Setup options. 
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About 50 shades of an ink color can be 
printed from one plate. Printers some­
times print a grayscale picture using two 
or more plates instead of one to extend 
the tonal range. The additional plate can 
be gray or a color tint. You can convert 
a picture to Duotone mode in Photoshop 
to create a duotone (two plates ), tritone 
(three plates), or quadtone (four plates). 

Note: Printing a duotone is complex. 
The proper order of inks must be selected 
in the Duotone options dialog box and 
then on the press. Ask your print shop 
for advice. A duotone effect cannot be 
"proofed" on a PostScript color printer. 

To create a duotone: 
1. Choose Grayscale from the Mode 

menu. 

2. Choose Duotone from the M ode 
menu (Figure 16). 

3. Choose Duotone from the Type 
pop-up menu (Figure 17). 

4. Click the Ink 2 color square. 

5. If necessary, click Custom. Choose 
from the Book pop-up menu, then 
type a color number or click a 
swatch. 
or 
If necessary, click Picker, then enter 
C,M, Y, and K percentages. 

6. Click OK or press Return. 

7. For a process color, enter a name next 
to the color square. 

8. Click the Ink 2 curve. 

9. Drag the curve in the Duotone 
Cu rve dia log box (Figure 18). 

10. Click OK or press Return. 

11. Click the Ink 1 curve, then repeat 
steps9and 10. 

V' Tip 
• The Photoshop Tutorial folder con­

tains dutone, tritone, and quadtone 
curves that you can use. (Click Load 
in the Duotone Options box) . 
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Figure 16. Choose Duotone 
from the Mode menu. 

Click a color square to choose a color. 
Click a curve 
to modify it. Enter a name for a process color. 

Jype: CEJ 
Ink 1: ( tance l ) 

I •••• ... I 
Ink 2: ( Snue ... ) 

lf1k .l: 

lflk •1: 

Figure 17. In the Duotone Options dialog box, choose 
Duotone from the Type pop-up menu, then click the Ink 2 
color square. 
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The picture's midtones. 

The picture's shadows. 
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Highlights. Shadows. 

Figure 18. With this curve shape in the Duotone Curve 
dialog box, Ink 2 will tint the picture's midtones. Make the 
Ink 1 curve different from the Ink 2 curve. 
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Preferences ~ General... WK 
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I Quit 88Q Plug-ins ••. 
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Transparency .•• 
Units .•• 

Monitor Setup ... 
Printing Inks Setup .•• 
Separation Setup •.. 
Separation Tables ..• 

Figure 1. The Preferences submenu under the File menu. 

DEFAULTS 23 
DEFAULTS ARE settings that are 

chosen to apply generally, such as 
which ruler units are used, or if 

channels display in color. Default dialog 
boxes are opened from the Preferences 
submenu under the File menu (Figure 1). 

Choose basic defaults in the General 
Preferences and More Preferences dialog 
boxes, such as whether file icons will 
contain a thumbnail preview of the pic­
ture, or which Color Picker will be used. 

Choose a color and an opacity of that 
color for displaying out-of-gamut colors 
in the Gamut Warning dialog box. 

Choose a hard disk to be used as 
Photoshop's extra work area in the 
Scratch Disks dialog box. 

Choose the grid size and color of the 
checkerboard used to represent transpar­
ent areas on a layer, or if no grid will 
be used, in the Transparency Options 
dialog box. 

Choose ruler units in the Units dialog 
box. 

Choose your monitor type and ambient 
lighting conditions in the Monitor 
Setup dialog box to optimize display 
and RGB-to-C!v1YK conversion. 

Adjust your monitor in the Gamma 
dialog box, opened from the Control 
Panels folder. 

Note: Don't move the program's internal 
Plug-Ins module out of the Photoshop 
folder unless you have a specific reason 
for doing so. Moving it could inhibit 
access to the Acquire, Export and File 
Format commands. Don't confuse 
the Plug-ins module with third-party 
plug-ins. 
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Key to the General Preferences dialog box. 

1 Choose the Photoshop Color Picker to 
access th e program's ow n Co lo r 
Picker. 

2 Choose an Interpolation option for 
reinterpretation of a picture as a result 
of resampling, scal ing, etc. Bicubic 
is s lowest, but the highest quality. 
Nea rest Ne ighbor is the fas test, but 
the poorest quality. 

3 Choose whether CMYK Composites 
for the R GB s cree n vers ion of a 
CMYK fi le wi ll be rendered Faster, 
but simpl er, or Smoother and mo re 
refined. 

4 Chec k Color Channels in Colo r to 
d isplay individua l RGB o r CMYK 
channels in color. Otherwise, they w ill 
display grayscale. 

5 Check Use System Palette to have the 
App le System Pa le tte be used 
rather than the document's own 

color palette. Turn this option on to 
correct the display of erratic colors on 
an 8-bit monitor. 

6 Check Use Diffusion Dither to smooth 
colors on an 8-bit monitor. 

7 Uncheck Video LUT Animation to 
disable the interactive screen preview 
if you are using a video card that is 
causing conflicts between Photoshop 
and your monitor. 

8 For Pa inting Tool Cursors (Gradient, 
Line, Eraser, Pencil , Airbrush, Paint­
brush, Rubber Stamp, Smudge, Blur/ 
Sharpen and Dodge/Burn/Sponge tools) 
choose Standard to see the icon of the 
tool being used, or choose Precise to 
see a crosshair icon, or choose Brush 
Size to see a round icon the exact size 
and shape of the brush tip (up to 300 
pixels). For other tools, choose Stan­
dard or Precise cursor icons. 

General Prefer ences 
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Figure 2. The General Preferences dialog box. 
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Defaults 

Key to the More Preferences dialog box. 

1 Check Image Previews/ Always Save: 
Icon to display a thumbnail of a pic­
ture in its fil e icon on the desktop. 
Click Thumbnail to display a thumb­
na il of a picture when its name is 
highlighted in the Open dialog box. 
Click Full Size to includ e a 72 dpi 
PICT prev iew for applications which 
require this option when importing 
non-EPS fi les. Click Ask When Saving 
to choose to save previews on a file­
by-file basis. 

2 Check Anti-alias Postscript to opti ­
mize the rendering of EPS graphics in 
Photoshop. 

3 Check Export Clipboard to have the 
current Clipboard contents stay on the 
Clipboard when you quit Photoshop . 

4 Check Short PANTONE Names if your 
picture contains Pantone colors and 
you are exporting it to another appli­
cation. 

5 Check Save Metric Color Tags if you 
are export ing yo ur file to Quark­
XPress and are using EFIColor. 

6 Check Beep When Tasks Finish for a 
beep to sound after any command, for 
which a progress bar displays, is com­
pleted. 

7 Check Dynamic Sliders in Picker to 
have the color bars over the Picker 
sliders update when the sliders are 
moved . 

8 Check 2.5 Format Compatibility to 
autom a ticall y save a flat tene d , 
Photoshop version 2.5 copy in every 
3.0 document. This option increases 
the file storage size. 

9 With Restore Palette & Dialog 
Positions checked, palettes and win­
dows that are open when you quit 
Photoshop will appear in their same 
location the next tim e you launch 
Photoshop. Uncheck Restore Palette 
& Dia log Positions to restore the 
palettes' default groupings. 

More Preferences 

, 

2 
3 
4 
5 

,- Image Preuiews n OK ]J 
QNeuer 

[ l ® Always Saue: [8] I con Cancel 

[8] Thumbnai l 

0 Full Size 

0 Aslc When Sauing 

r- 0 Anti-alias PostScript 0 Beep When Tasks Finish 

f- 0 EKport Clipboard 0 Dynamic Sliders in Pic leer 

f- 0 snort PANTON£ Names 0 2.5 Format Compatibility 

f- 0 Saue Metric Color Togs [8] Restore Palette & Dialog Positions -

Figure 3. The More Preferences dialog box. 
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Chapter 23 

The Primary and Secondary scratch 
disks a re used when available RAM is 
insufficient for processing or storage. 

To choose scratch disks: 
1. Choose Scratch Disks from the 

Preferences submenu under the File 
menu (Figure 4). 

2. Choose an available hard drive from 
the Primary pop-up menu. Startup is 
the default (Figure 5). If you only have 
one hard drive, you will only be able 
to choose a Primary Scratch Disk. 

3. Optional: Choose an alternate hard 
drive from the Secondary pop-up 
menu to be used as extra work space 
when necessary. 

4. Click OK or press Return. 

5. For the changes take effect, choose 
Quit from the File menu, then launch 
Photoshop again. 

V Tip 
• If you choose a removable cartridge 

as a Scratch Disk, don't remove the 
cartridge while Photoshop is running 
or the program may crash. 

Choose Show Rulers from the Window 
menu to display rulers on the top and 
left sides of the document window. The 
position of the pointer will be indicated 
by a mark on each ruler. 

To choose ruler units: 
1. Choose Units from the Preferences 

submenu under the File menu (Figure 
4). 

2. Choose a unit of measure from the 
Ruler Units pop-up menu (Figure 6). 

3. Click OK or press Return. 

V Tip 
• If you change the ruler units, the 

Info palette units will also change, 
and vice versa. 
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Figure 5. Choose a Primary and Secondary scratch disk in the 
Scratch Disk Preferences dialog box. 
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Figure 6. Choose a unit of measure from the Ruler Units 
pop-up menu in the Unit Preferences dialog box. 
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Figure 8. In the Monitor Setup dialog box. choose your mon­
itor rype from the Monitor pop-up menu, and choose Low, 
Medium, or High from the Ambient Light pop-up menu. 

Defaults 

Follow the instructions on this page and 
the next page to adjust your monitor 
for Photoshop. These a re the first steps 
in monitor-to-output calibration. See the 
Photoshop User Guide for information 
about calibrating your system. 

Note: After choosing monitor specs and 
making your desktop gray (instructions 
on the next page), adjust the brightness 
and contrast knobs on your mon itor and 
do not change them (put tape on them, 
if necessary). Then fo llow instructions on 
the next page to adjust the Gamma. 

To choose Monitor Setup 
options: 
1. Choose Monitor Setup from the 

Preferences submenu under the File 
menu (Figure 7). 

2. Choose your monitor name from 
the Monitor pop-up menu. If it's not 
listed, consult the documentation 
supplied with your monitor to find 
the closest equivalent (Figure 8). 

3. Choose the manufacturer of your 
CRT from the Phosphors pop-up 
menu. This information should also 
be supplied with your monito r. 

4. Choose Low, Medium, or High from 
rhe Ambient Light pop-up menu. 

5 . Click OK or press Return. 

v Tips 
• Leave the Gamma at 1.80 and the 

White Point at 6500oK, unless you 
have a specific reason to change it. 

• The Monitor Setup affects color 
substitution when a picture is con­
verted from RGB Color mode to 
CMYK Color mode. 

• Try to keep the light in your com­
puter room consistent while you're 
working. 
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Chapter 23 

Use the Gamma Control Panel to make 
your monitor grays more neutral and 
monitor color a little more accurate. If 
your desktop is already gray, proceed 
directly to "To adjust the Gamma." 

To make the Desktop gray: 
1. Choose Control Panels from the 

Apple menu . 

2. Double-click General Controls in the 
Control Panels folder. 

3. Click the left or right triangle to 
locate the gray Desktop pattern, then 
click the gray pattern in the same 
window (Figure 9). 

4. Click the General Controls close box. 
{Adjust the brightness and contrast 
knobs on your monitor. See the "Note" 
on the previous page) 

To adiust the Gamma: 
1. Choose Control Panels from the 

Apple menu. 

2. Double-click Gamma. 

3. Click Target Gamma: 1.8 if you 
plan to print your pictures (Figure 10). 

4. Hold up a white piece of paper next 
to the monitor. The warm or cool 
cast of the paper will affect the 
Gamma settings you choose. 

5. Click the White Pt button, then 
move the White Point sliders until 
the rightmost square on the calibra­
tion bar matches the paper. 

6. Click the Black Pt button, then 
move the Black Pt sliders until the 
dark calibration squares look neutral. 

7. Click the Balance button, then 
move the Balance sliders until the 
gray calibration squares look neutral. 

8. M ove the Gamma Adjustment slider 
to blend the light and dark bars. 

9. Readjust any of the sliders, if needed. 

10. Optional: Click Save Settings, then 
rename and save the Gamma settings. 

11. Click the Gamma close box. 
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Figure 9. Choose a gray Desktop Pattern in 
the General Controls dialog box. 
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Alpha channel 

A special 8-bit grayscale channel used 
for saving a selection. 

Anti-alias 

The blending of pixel colors along the 
perimeters of hard-edged shapes, such as 
type, to smoooth undesirable stair­
stepped edges, or "jaggies." 

ASCII 

(American Standard Code for Informa­
tion Interchange) A standard editable 
format for encoding data. 

Background color 

The color applied when the Eraser tool 
is used or when selected (non-floating) 
pixels are moved or deleted. 

Bezler curve 

A curved line segment drawn using the 
Pen tool. It consists of anchor points 
with direction lines with which the 
curve can be reshaped. Bezier curves can 
also be created using illustration soft­
ware. 

Binary 
In Photoshop, a method for encoding 
data. Binary encoding is more compact 
than ASCII encoding. 

Bit 
(Binary digit) The smallest unit of infor­
mation on a computer. Eight bits equal 
one byte. (see Byte) 

Appendix A: Glossary 

Bit depth 
The number of bits used to store a 
pixel's color information on a computer 
screen. 

Bitmap 
The display of a picture on a computer 
screen via the geometric mapping of a 
single layer of pixels on a rectangular 
grid. In Photoshop, Bitmap is also a 
one-channel mode consisting of black 
and white pixels. 

Blend (see Gradient) 

Brightness (see Lightness) 

Burn 
To darken an area of a picture. 

Byte 
The basic unit of storage memory. One 
byte is equal to eight bits. 

Canvas size 
The size of a picture, including a border, 
if any, around the image. 

CD· ROM drive 
A special digital drive for reading CD­
ROM disks. One CD disk can store at 
least 650 megabytes of information. At 
this writing, most CD-ROM drives are 
read-only, and are used as a source for 
stock photographs, fonts, software, 
games, clip art, etc. 

Channel 
A color "overlay" which contains the 
pixel information for that color. A 

257 



Appendix A 

grayscale picture has one channel, an 
RGB picture has three channels, and a 
CMYK picture has four channels. 

Clipboard 
An area of memory used to temporarily 
store a selection. The Clipboard is 
accessed via the Cut, Copy, and Paste 
commands. 

Clipping 
In Photoshop, the automatic desatura­
tion of colors that are too pure to print 
properly. 

Clone 
To duplicate all or part of a picture 
using the Rubber Stamp tool. 

CMYK 
(Cyan, Magenta, Yellow, and Black) The 
four colors of ink used in process print­
ing. Cyan, Magenta, and Yellow are the 
three subtractive primaries. When com­
bined in their purest forms, they theoret­
ically produce black. Actually, they pro­
duce a dark muddy color. CMYK colors 
are simulated on a computer screen 
using additive colors. To color separate 
a picture from Photoshop, it must be in 
CMYK Color mode. 

Color correction 
The adjustment of color in a picture to 
match original artwork or a photo­
graph. Color correction is usually done 
in CMYK Color mode to prepare for 
process printing. 

Color separation 
The production of a separate sheet of 
film for each color of ink that will be 
used to print a document. Four plates 
are used in process color separation, one 

258 

each for Cyan, Magenta, Yellow, and 
Black. 

Color table 
The color palette of up to 256 colors of 
a picture in Indexed Color mode. 
Sometimes referred to as a color palette. 

Continuous-tone image 
A picture, such as a photograph, in 
which there are smooth transitions 
between gray shades or colors. 

Contrast 
The degree of difference between lights 
and darks in a picture. A high contrast 
picture is comprised of only the lightest 
and darkest pixels. 

Crop 
To cut away part of a picture. 

Crop marks 
Short, fine lines placed around the edges 
of a page to designate where the paper is 
to be trimmed by a print shop. 

DCS 
(Desktop Color Separation) A file for­
mat in which a color picture is broken 
down into five PostScript files: Cyan, 
Magenta, Yellow and Black for high res­
olution printing, and an optional low 
resolution PICT file for previewing and 
laser printing. 

Defloat 
To replace underlying pixels with the 
contents of a floating selection. A selec­
tion remains active when it is defloated. 

Defrlnge 
A technique used for softening the edge 
of a selection inward from the marquee 
a specified number of pixels. 



Digitize 

To translate flat art or a transparency 
into computer-readable numbers using a 
scanning device and scanning software. 

Dimensions 
The width and height of a picture. 

Disk 
A carrying medium for processing, read­
ing, and storing electronic files, such as 
a hard drive, floppy disk, or CD-ROM 
disk. 

Dither 
The mixing of adjacent pixels to simu­
late additional colors when available 
colors are limited, such as on an 8-bit 
monitor. 

Dodge 
To bleach (lighten) an area of a picture. 
Also, a so-so car model. 

Dot gain 
The undesirable spreading and enlarging 
of ink dots on paper. 

DPI 
(Dots Per Inch) A unit used to measure 
the resolution of a printer. DPI is some­
times used to describe the input resolu­
tion of a scanner, but ppi, or "sampling 
rate" is a more accurate term. 

Duotone 
A grayscale picture printed using two 
plates for added tonal depth. A tritone 
is printed using three plates. A quadtone 
is printed using four plates. 

Glossary 

Dye sublimation 
A continuous-tone printing process 
in which a solid printing medium is con­
verted into a gas before it reaches the 
paper. Each printing color can vary in 
intensity. 

8-bit monitor 
A monitor in which each pixel stores 
eight bits of information and represents 
one of only 256 available colors. 
Dithering is used to create the illusion of 
additional colors. 

EPS 

(Encapsulated PostScript) A picture file 
format containing PostScript code and, 
in the case of Photoshop, an optional 
PICT image for screen display. EPS is a 
commonly used format for moving files 
from one application to another and for 
imagesetting and color separating. 

Equalize 
To balance a picture's lights and darks. 

Feather 
To fade the edge of a selection a speci­
fied number of pixels (the Feather 
Radius). 

Fill 
To fill a selection with a shade, color, 
pattern, or blend. 

Film negative 
A film rendition of a picture in which 
dark and light areas are reversed. 

Floating selection 
An area of a picture that is surrounded 
by a marquee and can be moved or 
modified without affecting underlying 
pixels. The Paste and Float commands 
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create floating selections. Newly created 
type also appears as a floating selection. 

Font 
A typeface in a distinctive style, such as 
Futura Bold Italic. 

Foreground color 
The color applied when a painting tool 
is used, type is created, or a Fill com­
mand is executed. 

Gigabyte 
(G, Gb) A unit of memory equal to 
1,024 megabytes. (see Megabyte) 

Gradient fill 
In Photoshop, a graduated blend be­
tween the Foreground and Background 
colors produced by the Gradient tool. 

Grayscale 
A picture containing black, white, and 
up to 256 shades of gray, but no color. 
In Photoshop, Grayscale is a one-chan­
nel mode. 

Halftone screen 
A pattern of tiny dots used for printing 
a picture to simulate smooth tones. 
(see Screen frequency) 

Highlights 
The lightest areas of a picture. 

Histogram 
A graph showing the distribution of a 
picture's color and/or luminosity values. 

HSB 
See Hue, Saturation, and Brightness. 

Hue 
The wavelength of light of a pure color 
that gives a color its name, such as red 
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or blue, independent of its saturation or 
brightness. 

lmageseHer 
A high-resolution printer (usually 1,270 
or 2,540 dpi) used to generate paper or 
film output from computer files. 

Indexed color 
In Photoshop, a color mode in which 
there is only one channel and a color 
table containing up to 256 colors. All 
the colors of an Indexed color picture 
are displayed in its Colors palette. 

Ink iet 
A color printer in which four colors of 
ink are forced through small holes to 
produce dots. 

Interpolation 
The recoloring of pixels as a result of 
changing a picture's dimensions or reso­
lution. Interpolation may cause a pic­
ture to look blurry when printed. You 
can choose an interpolation method in 
Photoshop. 

Inverse 
To switch the selected and non-selected 
areas of a picture. 

Invert 
To reverse a picture's light and dark val­
ues and/or colors. 

Jaggies 
Undesirable stair-stepped edges of com­
puter rendered images. (see Anti-alias} 

JPEG compression 
(Joint Photographic Experts Group) A 
compression feature in Photoshop that 
can be used to reduce the storage size of 



a file. Some information is lost during 
JPEG Compression. 

Kern 
To adjust the horizontal spacing 
between a pair of characters. 

Kilobyte 
(K, Kb) A unit of memory equal to 
1,024 bytes. (see Byte) 

Lab 
A mode in which colors are related to 
the CIE color reference system. In 
Photoshop, a picture in Lab Color mode 
is composed of three channels, one for 
lightness, one for green-to-magenta col­
ors, and one blue-to-yellow colors. 

Leading 
The space between lines of type, mea­
sured from baseline to baseline. In 
Photoshop, leading can be measured in 
points or pixels. 

Lightness 
(Brightness) The lightness of a color 
independent of its hue and saturation. 

Linear fill 
A straight gradation from edge to edge. 
(see Radial fill) 

LPI 
(Lines Per Inch, halftone frequency, 
screen frequency) The unit used to mea­
sure the frequency of rows of dots on a 
halftone screen. 

Luminosity 
The distribution of a picture's light and 
dark values. 

Marquee 
The moving border that defines a selec­
tion. 

Glossary 

Mask 
A device used to protect an area of a 
picture from modification. 

Megabyte 
(M, MB) A unit of memory equal to 
1,024 kilobytes. (see Kilobyte) 

Mldtones 
The shades in a picture midway between 
the highlights and shadows. 

Mode 
A method for specifying how color 
information is to be interpreted. A pic­
ture can be converted to a different 
mode using the Mode menu; a mode can 
be chosen for a painting or editing tool 
via palette pop-up menus. Grayscale, 
RGB Color, CMYK Color, and Lab 
Color are commonly used picture 
modes. 

Moires 
Undesirable patterns caused by the use 
of improper halftone screen angles or 
when the pattern in an image conflicts 
with proper halftone patterns. 

Noise 
In Photoshop, filters that randomly 
recolor pixels to create a texture or 
make an image look grainy. 

Oblect-orlented 
(also known as vector) A software 
method used for describing and process­
ing computer files. Object-oriented 
graphics and PostScript type are defined 
by mathematics and geometry. 
Bitmapped graphics are defined by pix­
els on a rectangular grid. Photoshop pic­
tures are bitmapped, not objected-ori­
ented. 
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Opacity 
The density of a color or shade, ranging 
from transparent to opaque. In 
Photoshop, the opacity for a painting or 
editing tool is specified by using the 
Brushes palette. 

PaleHe 
A floating window used to specify 
options for a tool or feature. Also, a col­
lection of color swatches displayed on 
the Colors palette. 

Path 
A shape composed of straight and/or 
curved segments joined by anchor 
points. Paths are created with the Pen 
tool and modified via the Paths palette. 

PICT 
A Macintosh file format used to display 
and save pictures. Save a Photoshop pic­
ture as a PICT file to open it in a video 
or animation program. PICT files 
should not be color separated. 

Pixels 
(Picture elements) The individual dots 
used to display a picture on a computer 
screen. 

PPI 
(Pixels per inch) A unit used to measure 
of the resolution of a scan or a picture 
in Photoshop. 

Plug-In module 
Third-party software placed in the 
Photoshop Plug-ins folder so it is acces­
sible from a Photoshop menu. Or, a 
plug-in module that comes with 
Photoshop that is used to facilitate the 
Acquire, Export, and file format conver­
sion operations. There is no icon for the 
plug-in module in the Finder. 
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Point 
A unit of measure used to describe type 
size (measured from ascender to descen­
der), leading (measured from baseline to 
baseline), and line width. 

Polygon 
A closed shape composed of three or 
more straight sides. 

Posterize 
Produce a special effect in a picture by 
reducing the number of shades of gray 
or color to the darkest shade, the light­
est shade, and a few shades in between. 

PostScript 
The page description language created 
and licensed by Adobe Systems Incor­
porated for displaying and printing 
fonts and pictures. 

Process color 
Ink printed from four separate plates, 
one each for Cyan (C), Magenta (M), 
Yellow (Y), and Black (K), which in 
combination produce a wide range of 
colors. 

Quick Mask 
In Photoshop, a screen mode in which a 
translucent colored mask covers selected 
or unselected areas of a picture. Painting 
tools can be used to modify a Quick 
Mask. 

Radial fill 
A gradation radiating from the center of 
the blend area outward. 

RAM 
(Random Access Memory) The system 
memory of a computer used for running 
an application, processing information, 
and temporary storage. 



Rasterize 
The conversion of an object-oriented 
picture into a bitmapped picture, such 
as when an Adobe Illustrator graphic is 
placed into Photoshop. All computer 
files are rasterized when printed. 

Registration marks 
Crosshair marks placed around the 
edge of a page that are used to align 
printing plates. 

Resample 
Modify a picture's resolution. Lowering 
a picture's resolution is called resam­
pling down. Increasing a picture's reso­
lution is called resampling up. Both 
cause interpolation. (see Interpolation) 

Resolution 
The fineness of detail of a digitized 
image (measured in pixels per inch), a 
monitor (measured in pixels per inch­
usually 72 ppi), a printer (measured in 
dots per inch), or halftone screen (mea­
sured in lines per inch). 

RGB 
Color produced by transmitted light. 
When pure Red, Green, and Blue light 
(the additive primaries) are combined, 
as on a computer monitor, white is pro­
duced. In Photoshop, RGB Color is a 
three-channel picture mode. 

Saturation 
The purity of a color. The more gray a 
color contains, the lower its saturation. 

Scan 
To digitize a slide, photograph or other 
artwork using a scanner and scanning 
software so it can be displayed, edited, 
and output from a computer. 

Glossary 

Scratch disk 
(also known as virtual memory) Hard 
drive storage space designated as work 
space for processing operations and for 
temporarily storing part of an image 
and a backup version of the image when 
there is insufficient RAM for these func­
tions. 

Screen angles 
Angles used for positioning halftone 
screens when producing film to mini­
mize undesirable dot patterns (moires). 

Screen frequency 
(also known as screen ruling) The reso­
lution (density of dots) on a halftone 
screen, measured in lines per inch. (see 
!pi) 

Selection 
An area of a picture that is isolated so it 
can be modified while rest of the picture 
is protected. A moving marquee denotes 
the boundary of a selection, and can be 
moved independently of its contents. A 
selection can contain underlying pixels 
or temporarily float above underlying 
pixels. 

Shadows 
The darkest areas of a picture. 

Sharpness 
The degree of fineness of detail of an 
image, of a computer monitor, and of 
printer output. 

Size 
The number of storage units a file occu­
pies, measured in kilobytes, megabytes, 
or gigabytes. 
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Spacing 
The space between brush marks created 
with painting and editing tools. Also, the 
horizontal space between letters, specified 
in the Type Tool dialog box. 

Spot color 
A mixed ink color used in printing. A sep­
arate plate is used to print each spot 
color. Pantone is a commonly used spot 
color matching system. 
(see Process color) 

Thermal wax 
A color printing process in which a 
sequence of three or four ink sheets are 
used to place colored dots on special 
paper. 

TIFF 
(Tagged Image File Format) A file format 
used for saving bitmapped images, such 
as scans. TIFF pictures can be color sepa­
rated. 

Tolerance 
The range of pixels within which a tool 
operates. For example, the range of 
shades or colors the Magic Wand tool 
selects and the Paint Bucket tool fills. 

Trap 
The overlapping of adjacent colors to pre­
vent undesirable gaps from occuring as a 
result of the misalignment of printing 
plates or paper. 

24·blt monitor 
A monitor with a video card in which 
each pixel can store up to 24 bits of infor­
mation. The card contains three color 
tables for displaying an RGB picture, one 
each for Red, Green, and Blue, and each 
contains 25 6 colors. Together they can 
produce 16.7 million colors. On a 24-bit 
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monitor, smooth blends can be displayed, 
so dithering is not necessary. 

Underlying pixels 
The pixels comprising the unmodified 
picture, on top of which a selection or 
placed image can float. 

VIrtual memory (see Scratch disk) 

.Zoom 
To enlarge or reduce a picture's display 
SIZe. 



Appendix B: Keyboard Shortcuts 

KEY: '~ Click 

File menu 
New .. . 
Open .. . 
Close .. . 
Save 
Print ... 
Quit 

Eclltmenu 
Undo 

The Clipboard 
Cut 
Copy 
Paste 
Fill dialog box 

Image menu 

Map commands 
Invert 
Equalize ... 
Threshold ... 

'~ '~ Double-dick 

Adlust commands 
Levels .. . 
Curves .. . 
Brightness/Contrast ... 
Color Balance .. . 
Hue/Saturation .. . 

Filter menu 
Reapply last filter chosen 
Last Filter dialog box 
Cancel a filter while a Progress 

dialog box is displayed 

····!\- Press and drag 

3€N 
3€0 
3€W 
3€ s 
3€P 
3€Q 

3€ Z, or Fl * 
3€ X, or F2 
3€ C, or F3 
3€ V, or F4 
Shift delete 

3€1 
3€ E 
3€T 

3€ L 
3€ M 
3€ B 
3€ y 
3€ u 

3€ F 
3€ Option F 

3€ . (period) 

*The Function key shortcuts listed in this appendix (Fl, F2, etc.) 
are the default Commands palette shortcuts. Follow the instructions 
on pages 22-23 to assign your own Commands palette shortcuts. 
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Select menu 
All 
None 
Float!Defloat 
Grow 
Show/Hide Edges 

Window menu 
Zoom In 
Zoom Out 
Show/Hide Rulers 
Hide/Show Brushes 
Show/Hide Picker 
Show/Hide Layers 
Show/Hide Info 
Show/Hide Commands 

Display sizes 
Enlarge display size 

Reduce display size 

Magnify selected area 
1:1 view 
Fit picture in document window 

PaleHes 
Shrink palette to a bar 

Show/Hide Toolbox and palettes 
Open/activate tool's Options palette 

Tools 

~A 
~D 
~J 
~G 
~H 

~ + 
~­
~R 
FS 
F6 
F7 
F8 
F9 

~ Space bar 'It (works with 
some dialog boxes open) 

Option Space bar ~ (works 
with some dialog boxes open) 

····~ with Zoom tool 
'It'~ Zoom tool on Toolbox 
'it'~ Hand tool on Toolbox 

·It ·l\- a palette tab or 
Option-click palette zoom box 
Tab 
Return or ·it it any tool other 
than Hand or Zoom 

With any painting or editing tool selected: 
Temporary arrow cursor ~ 
Opacity percentage (Options palette) Keypad key 0=100%, 

Change to next larger brush size 
Change to next smaller brush size 

1=10%, 2=20%, etc. 
[ 
] 

Channels paleHe 
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RGB Channels 
RGB 
Red 
Green 
Blue 

~ 0 
~1 
~ 2 
~ 3 



CMYK Channels 
CMYK 
Cyan 
Magenta 
Yellow 
Black 

Hanel tool 
Temporary Hand tool with any 

other tool selected 

Eyedropper tool 
Select color for the non-highlighted 

color square 
Temporary Eyedropper tool with 

Paint Bucket, Gradient, Line, Pencil, 
Airbrush, or Paintbrush tool selected 

Eraser tool 

Keyboard Shortcuts 

3€ 0 
3€ 1 
3€2 
3€3 
3€4 

Space bar 

Option '~ color 
Option 

Magic eraser, restores last saved version Option ····~ 
Constrain eraser to 90° angle Shift ····~ 

Line tool 
Constrain to 45° or 90° angle Shift····~ 

Pencil, Airbrush, Rubber Stamp, Smudge tool 
Constrain to 90° angle Shift ····~ 

Pen Tool 
Add anchor point with Path Select 

tool highlighted 
Delete anchor point with Path Select 

tool highlighted 
Constrain straight line segment 

or anchor point to 45° angle 
Delete last created anchor point 
Erase path being drawn 
Temporary Path Select tool with 

any Pen tool selected 
Temporary Convert-direction point 

tool with the Path Select tool or 
any Pen tool selected 

Sharpen/Blur tool 
Switch between Sharpen and Blur 

3€ Option '~ line segment 

3€ Option '~ anchor point 

Shift····~ 

Delete 
Delete Delete 

3€ Control 

Option ····~ picture or 
Option 'i\- Sharpen/Blur 
tool on Toolbox 
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Smudge tool 
Temporary Finger Painting tool 

Selections 
Add to a selection 
Subtract from a selection 
Float a selection 
Move selection marquee 
Move selection marquee, Move tool 

selected 
Move selection in 1-pixel increments 
Move selection in 1 0-pixel increments 
Maintain proportions of Scale 
command marquee 

Fill selection with Foreground color 
Switch Masked Areas/Selected Areas 

Rectangular Marquee and 
Elliptical Marquee tools 

Draw selection from center 
Square or circlular selection 

Magic Wand tool 
Add to a selection 
Subtract from a selection 
Temporarily select wand tool with 

Marquee or Lasso tool selected 

Lasso tool 
Create straight side in a selection 
Create curved side in a straight-sided 

selection 

Dialog boxes 
Restore original settings 
Delete to the right of the cursor 
Highlight next field 
Highlight previous field 
Increase/decrease number in 

highlighted field by 1 unit 
Increase/decrease number in 

highlighted field by 10 units 
Cancel out of dialog box 

Swatches paleHe 
Delete a color 
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Replace swatch with new color 
swatch 

Insert new color between two colors 

Option ····~t-

Shift ····~t­
ag .... It-
Option ····~t- selection 
3€ Option ····It' selection 

Option ····~t- selection 
Arrow keys 
Shift and Arrow keys 

Shift ····~t- corner box 
Option Delete 
Option '~ Quick Mask icon 
on Toolbox 

Option ····It­
Shift ····~t-

Shift ·it 
3€ 'it 

Control 

Option'~ 

····It or Option ····It' 

Hold down Option, click Reset 
del 
Tab 
Shift Tab 

Up or down arrow 

Shift and Up or down arrow 
3€ . (period) 

Shift it color to be replaced 
Option Shift 'it 



Layers palefte 
Select all pixels on layer 
Choose layer directly below target layer 
Choose layer directly above target layer 
Choose topmost layer 
Choose bottommost layer 
Add a new layer to the Layers palette 
Turn on/off Preserve Transparency 

option on Layers palette 
View layer mask channel 

Temporarily hide layer mask effects 
Choose a layer from the document 

window with Move tool selected 

Print preview box 
Picture information 

Keyboard Shortcuts 

a€ Option T 
a€[ 
a€] 
a€ Option] 
a€ Option [ 
Option'~ new layer icon 
I 

Option'~ layer mask 
thumbnail 

a€ '~ layer mask thumbnail 

a€ ·" object in picture 

Option hold down on 
Sizes bar 
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A 
Add Noise filter, 217, 225, 227 
Adjust commands, 99, 104-107, 109-110, 

122-128, 131 
Adobe Illustrator, 

create type in, 177, 
export a path to, 176 
import type from, 184 
open a picture created in, 42 
place a picture from, 43 
save a picture to open in, 52, 53 

Adobe Type Manager, 177 
Airbrush tool, 133-134, 140 
All command, 65 
Alpha channel, 31, 157-163 

convert into a path, 168 
delete, 163 
display, 159 
load, 159, 161 
modify mask color/opacity, 162, 164-165 
rename, 163 
reverse colors, 163-165 
save selection to, 158, 160 

Anti-aliased, 
default, 253 
for type, 177-178 
when opening a picture, 42-43 

Arrow keys, 84 
Arrows, 141 

B 
Background color, 15, 76, 84, 111-114, 

195, 197, 201 
Behind mode, 180, 199 
Bitmap mode, 29 
Blur filter, 210 
Blur tool, 191-192 
Border, add to a picture, 4 7 
Brightness, adjust, 99-110 
Brightness/Contrast dialog box, 104, 109 
Brushes palette, 2, 17, 139 
Brush tip, 

create, 137-138 

Index 

c 

delete, 137 
modify, 136 

Canvas Size, 4 7 
CD-ROM, 30, 40-41 
Channels, 27-28 
Channels, alpha, see Alpha Channel 
Channels palette, 2, 19, 27, 157-163, 165, 

168,217 
Clear command, 85-86 
Clipboard, 83, 86-89 
Clipping group of layers, 152, 185 
Clipping path, 175-176 
Clone, 203-206 
Close a picture, 57 
Close box, 2-3 
CMYK Preview, 130 
Color, 

adjust, 123-131 
Background, 15,84,111-114,197,201 
choose, 111-114 
CMYK, 27-29, 112, 130, 242-247 
custom, 113 
default, 111, 117, 162 
delete, 116 
fill selection with, 119, 121 
Foreground, 15, 111-114, 195, 197, 201 
mix, 16 
non-printable, 112, 130 
palettes, 2, 15-16, 111-118 
Pantone, 113 
process, 113 
replace, 124-125 
save, 118 
separations, print, 242, 246-247 
Trumatch, 113 

Color Balance, 126 
Color Halftone filter, 222 
Colorize a Grayscale picture, 122, 126, 250 
Color Modes, see Modes 
Color palettes, 15-16 

add color to, 116 
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append, 118 
choose color from, 114 
delete a color from, 116 
load swatch palette, 117 
mix color on, 115 
save, 118 

Color Picker, 112, 252 
Color printer, 245-246 
Color Range command, 70-71 
Color Table, 238-240 
Commands palette, 22-23 
Compress/Decompress EPSJPEG, 242 
Compression, file, 242 
Contrast, adjust, 99-110 
Copy command, 86-90 
Crop, 

a picture, 48-49 
a scan, 36 

Crop marks, 248-249 
Crystallize filter, 232 
Custom Colors dialog box, 113 
Cut command, 86-88 

D 
Darken mode, 135 
Default Brushes, 139 
Default colors icon, 111, 143, 162 
Default Swatches palette, 117 
Defaults, 251-254 

Function keys, 22-23 
monitor setup, 255 
plug-ins, 251 
ruler units, 254 
scratch disks, 254 

Define Pattern command, 229 
Defloat command, 85, 186 
Defringe command, 80 
Delete a floating type selection, 186 
Delete a layer, 97 
Deselect a selection, how to, 72 
Dialog boxes, how to use, 13 
Dimensions, 

modify, 44 
of a new picture, 38 
of Clipboard contents, 87 

Disk storage, 24 
Display modes, 62 
Display size, modify, 59-61 
Dissolve mode, 135 
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Dither, 252 
Document, see File 
Dodge/Burn/Sponge tool, 108, 129-130 
Drag-and-drop, 96 
Drop Shadow brushes, 143 
Drop shadow, create a, 143, 188 
Duotone, 250 
Duplicate a layer, 153 
Dye sublimation printer, 246 

E 
Edges, 

sharpen or blur, 191-192 
smudge, 193-194 

Editing tools, 4-5 
Edit menu, 9 
Elliptical marquee, 66 
Emboss filter, 214 
EPS, 

DCS file, 24 7 
open as a new document, 42 
place from Illustrator, 43 
save a picture as, 52 

Equalize command, 101 
Eraser tool, 133,144 
Export, 

a path, 176 
Clipboard, 86, 253 

Eyedropper tool, 114-115 

F 
Fade-out distance, 133-134 
Feather command, 78, 172,200,221,231-232 
File (document), 

close, 57 
compression, 24 7 
create a new, 36, 38 
formats, 30, 52 
menu, 9 
open, 39-42 
save a new, 52 
save a new version of, 55-56 
size, 7, 37-38, 44 
size units, 24 

Fill, 
a path, 175 
a selection, 119, 121 
Paint Bucket, 142 
pattern, 229 



tools, 4 
type, 180 

Film recorder, 247 
Filter menu, 11 
Filters, 209-236 

Add Noise, 217, 225, 227 
Blur, 210 
Color Hafltone, 222 
Crystallize, 232 
Emboss, 214 
Find Edges, 212, 227, 230 
Gaussian Blur, 189, 227 
Lighting Effects, 233-236 
Median, 223 
Mezzotint, 154 
Minimum, 213,223 
Mosaic, 228 
Motion Blur, 225, 231-232 
Ripple, 218,221 
Sharpen, 211 
Solarize, 186 
Tiles, 224 
Trace Contour, 213 
Twirl, 220-221,226 
Unsharp Mask, 42 
Wind, 215-216 
Zigzag, 219, 221 

Find Edges filter, 212, 227, 230 
Finger painting option for Smudge tool, 193 
Flatten Image command, 155 
Flip, 

a picture, 50 
a selection, 74 

Float command, 26, 85, 121 
Floating selection, defined, 7, 26, 83, 85 
Foreground color, 15, 111-114, 138, 195, 

197,201 
Frame selection, create, 71 
Function keys, 22-23 

G 
Gamma, 256 
Gamut Warning, 130-131 
Gaussian Blur filter, 189, 227 
General Preferences, 251-25 6 
Glossary, 

main, Appendix A, 
mini, 7 

Index 

Gradients, 195-202 
Foreground/Background to transparent, 

196,202 
in a selection, 200 
in type, 197 
linear, 195-197 
multiple, 201-202 
radial, 198 

Grayscale picture, 
colorize, 122 
mode, 29 

Grow command, 68 

H 
Halftone screen frequency, 35, 247 
Hand tool, 62-63 
Hard Light mode, 135 
Hardware requirements, 24 
Hide/Show Edges command, 74, 197 
High contrast, make a picture, 1 02, 1 OS 
Highlights, adjust, 126-128, 142-144 
Hue mode, 135 
Hue/Saturation dialog box, 122-123, 214, 

216,225 

I 
Image menu, 10 
Imagesetter, 246 
Image Size dialog box, 44-45 
Indexed Color mode, 29, 237-240 

choose Spectrum table for, 239 
convert to, 237 
edit color table of a picture in, 238-239 
recolor, 240 

Info palette, 21, 66, 73, 254 
Interpolation, 46 
Inverse command, 79, 82, 182, 221 
Invert command, 100, 106, 159, 212-213 

J 
JPEG Compression, 242 

K 
Keyboard shortcuts, 

assign using Commands palette, 22-23 
how to perform, 23 
list of, Appendix B, 265-269 
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L 
Lab Color mode, 30, 41, 245-246 
Laserwriter, 243-244 
Lasso tool, 67-68, 71-73, 77-78,200 
Launch Photoshop, 33 
Layers, 91-98, 145-156 

blend, 146 
clipping group, 152, 185 
copy, 95-96 
create, 92 
delete, 97 
drag-and-drop, 96 
duplicate, 153-154 
flatten, 155 
hide/display, 98 
link, 151 
make, 93 
mask, 147-150 
merge, 155 
mode of, 92, 98, 147 
move, 94 
new, 92 
opacity of, 145 
preserve transparency of, 98 
restack, 94 
thumbnails, 92, 148 
turn a floating selection into, 93 

Leading, 178 
Levels dialog box, 105-107, 181-182, 214, 

225-226 
Lighten mode, 135 
Lighting Effects Filter, 233-236 
Lights and darks, modify, 99-110 
Linear blend, 195-197 
Lines, 

calligraphic, 140 
straight, 141 

Line tool, 133, 141 
Load Selection command, 159, 161 
Luminosity mode, 135 
LZW compression, 53,242 

M 
Magic eraser, 144 
Magic Wand tool, 65, 68-69, 72-73, 77 
Make Alias command, 33 
Make Layer command, 93 
Map commands, 99-103 
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Marquee tool, 65-66, 71-73, 77-79, 84-85 
Masks, 147-150, 157-165 
Median filter, 223 
Menu, 

Edit, 9 
File, 9 
Filter, 11 
how to use a, 8 
Image, 10 
Mode, 10 
Select, 11 
Window, 12 

Menu bar, 2-3 
Merge Layers command, 155 
Mezzotint filter, 154 
Midtones, adjust, 105, 108-110, 181-183, 190 
Minimum filter, 213,223 
Modes, 

choose for floating section, 93, 135 
image, 28-30, 38, 42 
menu, 10 
screen display, 62 
tool, 31, 135 

Monitor setup dialog box, 251, 255 
Mosaic filter, 228 
Motion Blur filter, 225, 231-232 
Mouse, how to use, 6 
Move, 

a layer, 94-96 
a picture in a window, 62-63 
a selection, 84 
a selection marquee, 73 
type, 179 

Multiply mode, 135 

N 
New document, see File 
New Layer command, 92 
New Window, 61, 130 
None command, 72 

0 
Opacity, 

of a Fill, 119, 121 
of a floating selection, 93, 121 
of a stroke, 120 
of a layer, 145 

Open a picture, 39-42 



Orientation, page, for printing, 246, 248 
Output, see Printing 
Overlay mode, 135 

p 
Page preview, 2-3, 241 
Page Setup dialog box, 244-246, 248 
Paintbrush tool, 133-135, 140 
Paint Bucket tool, 133, 142 
Painting tools, 4, 133-144 
Palettes, 14 
Paste command, 86-90 
Paste Into command, 86-89 
Paste Layer command, 86 
Path, 

about, 167 
clipping, 175 
convert alpha channel into, 168 
convert a selection into, 168 
convert into a selection, 172 
create, 169 
delete, 172 
deselect, 172 
display, 171 
export to Adobe Illustrator, 176 
fill, 175 
hide, 171 
reshape, 173 
save, 171 
select, 171 
stroke, 174 

Paths palette, 20, 167-175 
Pencil tool, 133, 140 
Pen tool, 

about, 167 
create a path using, 169-170 
reshape a path using, 173 

Photo CD, 34, 40-41 
Photograde, 244 
Photoshop, 

file format, 52, 158 
launch, 33 
quit, 58 

Picker palette, 15, 114 
PICT, 

save a picture as, 53 
save a selection in, 158 

Pixels, 7, 25 
Place a picture from Adobe Illustrator, 43 

Plug-ins, 36, 251 
Polygon selection, 67 
Posterize, 103 
PostScript Level-2, 30, 245-246 
Preferences, 

General, 251-253 
Monitor Setup, 251, 255 
More, 253 
Scratch Disks, 251, 254 
Units, 221, 254 

Preserve Transparency for layers, 98 
Preview option, 99, 123 
Printing, 241-250 

color, 245-246 
color separations, 242, 246 
devices, resolution of, 241 
dye sublimation, 246 
film recorder, 24 7 
imagesetter, 246 
laserwriter, 243-244 
options, 248-249, 243 
potential gray levels, 37 
preview box, 2-3, 241 
questions for offset printing, 242 
registration marks, 248-249 
tips, 242 

Process color, mix a, 112 

Q 
QuarkXPress, 

open a Quark EPS page, 40 
print a Photoshop picture from, 24 7 
save a picture to open in, 52-53 

Quick Mask, 31, 157, 164-165 
Quit Photoshop, 58 

R 
Rectangular marquee, 66, 71, 77, 79, 

228-229 
Registration marks, 248-249 
Replace Color command, 124-125 
Reposition, see Move 
Resample, 45 
Reset, 

dialog box, 13 
palettes, 17, 115-117 
tools, 17 

Resize, 
a crop marquee, 48-49 

Index 
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Index 

a palette or window, 2-3, 15 
a picture, 44 
a selection, 76 

Resolution, 
Auto, 45 
modify, 44-45 
monitor, 30, 60 
of Clipboard contents, 86-87 
of new document, 38, 41 
printer, 241 
scan, 35 
type, 177 

Restack a layer, 94 
Revert, 32, 54 
RGB Color, 

channels, 27-28 
mode, 28-29 
output, 28-29, 247 

Ripple filter, 218, 221 
Rotate, 

a crop marquee, 48-49 
a picture, 51 
a selection, 7 5 

Rubber Stamp tool, 32, 44, 115, 201, 203-
208,229 

Ruler units, 2-3, 251, 254 

5 
Sample Merged, 69, 204 
Saturation mode, 135 
Save, 

a new document, 52 
a new version of a document, 55 
an existing file, 54 
as EPS, 52 
as PICT, 53 
as TIFF, 53 

Save a Copy, 56, 155 
Save As (new version of a file), 30, 55 
Save Selection command, 158, 160 
Scale command, 76, 184 
Scan into Photoshop, 36 
Scanning, 34-36, 45, 242 
Scan sizes, 37 
Scratch Disk Preferences dialog box, 251, 254 
Scratch palette, 16, 115 
Screen back, 

a picture, 106, 182, 190 
type, 181, 183 
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Screen display modes, 62 
Screen modes, 135 
Scroll arrows, bars, boxes, 63 
Selection, 

add to, 77 
circular, 66 
color edge of, 120 
Color Range command, 70-71 
convert into path, 168 
convert path into, 172 
copy, 86-88 
defined, 7, 25-26, 65 
Defringe, 80 
deselect, 72 
elliptical, 66 
entire picture, 65 
feather, 78 
fill, 137, 139 
flip, 74 
Float/Defloat, 85 
floating, defined, 7, 83 
frame, 71 
Grow command, 68 
hide marquee (Hide Edges), 74, 197 
Inverse, 82 
irregular 67 
Lasso tool, 67-68, 71-73,77-78, 200 
Magic Wand tool, 65, 68-69, 72-73, 77 
Marquee tool, 65-66, 71-73, 77-79, 84-85 
move, 83-84 
move marquee, 73 
polygon, 67 
rectangular, 66 
resize, 76 
rotate, 75 
save to a channel, 158, 160 
Similar command, 68 
smooth, 81 
square, 66 
stroke, 174 
subtract from, 77 
tools, 4, 65-69, 73 
type, 177-184, 186 

Select menu, 11 
Selective Color command, 131 
Shadows, 

change colors in, 109-110, 124-128, 
130-131 

drop, 143, 188 



type, 188-190 
Sharpen filter, 185, 211 
Shortcuts, keyboard, 

about, 23 
list, Appendix B 

Show/Hide Edges command, 74, 197 
Similar command, 68 
Size, 

file, 7, 24, 28, 37 
image, 44-45 

Sizes bar, 2-3, 241 
Smudge, 191, 193-194 
Soft Light mode, 135 
Solarize filter, 212 
Sponge tool, 129-130 
Stroke, 

a path, 174 
a selection, 120 

Swatches palette, 16, 116-118 
Switch colors icon, 111, 162, 164 
System Palette, default, 252 

' Texture, 
spaghetti, 22 7 
woven, 225-226 

Texturize a pattern, 230 
Threshold dialog box, 102, 1 05 
TIFF, 

CMYK,247 
save a picture as a, 53 
save selection in a, 158 

Tiles filter, 224 
Tint a Grayscale picture, 122, 126, 250 
Title bar, 2-3 
Tolerance, for Magic Wand tool, 68-69 
Toolbox, 4-5 
Trace Contour filter, 213 
TrueType fonts, 177 
Trumatch colors, 113, 117 
TWAIN AcquirefTWAIN Select Source, 36 
Twirl filter, 220-221, 226 
Type, 177-190 

alignment, 178 
apply filter to, 216 
clipping group, 152, 185 
create, 178 
Defloat, 186 

delete, 186 
deselect, 186 
fading, 187 
fill with a gradient, 195-198 
fill with an image, 184-185 
fill with a pattern, 184 
fonts, 178 

Index 

from Adobe Illustrator, 42-43, 177, 246 
Ia yer mask, 148 
leading, 178 
move, 179 
place on own layer, 1 79 
recolor, 180 
screen back, 181, 183 
screen back a picture with, 182 
shadow, 188-190 
size, 178 
spacing, 178 
style, 178 
ways to modify, 184 

Typeface, see Fonts 

u 
Underlying pixels, 

defined,7,25,65,83 
restore under floating selection, 146 

Undo command, 9, 32,72 
Unit Preferences dialog box, 251, 254 
Unsharp Mask filter, 46, 48 

v 
Variations dialog box, 109-110, 127-128 
Vignette a picture, 79 

w 
Wet Edges option, 133-134 
Wind filter, 215-216 
Window, create a new, 61, 130 
Window menu, 12, 38, 59 

z 
Zigzag filter, 219, 221 
Zoom box, 2-3 
Zoom In/Zoom Out commands, 59-60 
Zoom tool, 60, 115 
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0 More from Peachpit Press 

25 Steps To Safe Computing 
Don Sellers 

With planning, many computer-related health 
problems can be avoided. 25 Steps to Safe 
Computing tells you how to reduce your risk 
with simple, easy-to-follow advice. It contains 
ergonomic tips on setting up work areas, as well 
as sections on backache, headache, tendinitis, 
radiation, pregnancy, carpal tunnel syndrome, 
and much more. $5.95 (72 pages) 

Director 4 for Macintosh: 
Visual QuickStart Guide 
Helmut Kobler and Andre Persidsky 

Learn the basics of Macromedia Director, 
including the paint window, tools, how to use 
color, animation techniques, setting the tempo, 
and more. $18.95 (248 pages) 

The Illustrator 5.0/5.5 Book 
Deke McClelland 

Experienced Illustrator users and novices alike 
will learn many helpful tips and techniques. 
Very thorough and comprehensive, The Illustrator 
5.015.5 Book gives in-depth coverage of Illustrator's 
latest features. $29.95 (660 pages) 

ColorCourse Interactive Training COs 
Color Expert 

ColorCourse/Photography demonstrates how to 
evaluate, scan, and separate photos for faithful 
reproduction. ColorCourse/Illustration covers 
trapping, scaling, blends, scanning specifications, 
and proofing. ColorCourse/Imagesetting focuses on 
getting the best final output possible with tips 
on topics like film imaging, proofing, quality 
assurance, and working with service bureaus. 
Includes a comprehensive trouble-shooting 
guide. Fully indexed with text links throughout. 
$49.95 each (CD ROM, available Fall '95) 

Photoshop in Black and White, 
2nd Edition 
Jim Rich and Sandy Bozek 

Updated to cover versions 2.5 and 3.0, this book 
explains how to adjust black-and-white images 
of any type for reproduction. Topics inlude 
image characteristics,; adjusting highlights, 
shadows, and midtones; sharpening images; and 
converting from color to greyscale. Appendices 
cover scanning, resampling and calibration. 
$18 (44pages) 

Photoshop in 4 Colors 
Mattias Nyman 

Find step-by-step procedures and detailed 
explanations on how to reproduce and 
manipulate color images using Photoshop and 
QuarkXPress. A terrific, invaluable resource for 
those who need high-quality color output. 
$22.95 (80 pages, available Fall '95) 

The Photoshop 3 Wow! Book 
(Mac Edition} 
Linnea Dayton and Jack Davis 

This book is really two books in one: an easy­
to-follow, step-by-step tutorial of Photoshop 
fundamentals and over 150 pages of tips and 
techniques for getting the most out of 
Photoshop version 3. Full color throughout, 
The Photoshop Wow! Book shows how professional 
artists make the best use of Photoshop. Includes 
a CD-ROMcontaining Photoshop filters and 
utilities. $39.95 (208 pages, includes CD ROM, 
available Falll995) 

Real World Scanning and Halftones 
David Blatner and Steve Roth 

Master the digital halftone process-from 
scanning images to tweaking them on your 
computer to imagesetting them. Learn about 
optical character recognition, gamma control, 
sharpening, PostScript halftones, Photo CD and 
image-manipulating applications like Photoshop 
and PhotoStyler. $24.95 (296 pages) 
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~\\t~\\on~ a.nd Answers About CopyJJ. ~" 
\t\\ By Tad Crawford, Esq. 7fhll 

1 Why is copyright important? 
If you are a creator of images (whether Photoshop user, photographer, 
designer, or fine artist), copyright protects you from having your images 
stolen by someone else. As the copyright owner, you may either allow or 
prevent anyone else from making copies of your work, making derivations 
from your work (such as a poster made from a photograph), or displaying 
your work publicly. Your copyrights las t for your lifetime plus another fifty 
years, so a successful work may benefit not only you but your heirs as well. 
If you are a user of images, it is important that you understand the rights 
and obligations connected with their use so you don't infringe on the copy­
right of someone else and expose yourself to legal or financial liabilities. 

2 What is an infringement? 
Infringement is unauthorized use of someone else's work. The test for 
infringement is whether an ordinary observer would believe one work was 
copied from another. 

3 Is it an infringement if I scan an old image into Photoshop 
and change it? 
If the image was created in the United States and is more than 75 years old, 
it is in the public domain and can be freely copied by you or anyone else. 
You will have copyright in the new elements of the image that you create. 

4 Is it an infringement if I scan a recent photograph into 
Photoshop and change it? 
The scanning itself is making a copy and so is an infringement. As a practi­
cal matter, however, it is unlikely you will be sued for infringement if you 
change the photograph to the point where an ordinary observer would no 
longer believe your work was copied from the original photograph. 

5 What does "fair use" mean in terms of copyright? 
A fair use is a use of someone else's work that is allowed under the copy­
right law. For example, newsworthy or educational uses are likely to be fair 
uses. The factors for whether a use is a fair use or an infringement are: 
(l) the purpose and character of the use, including whether or not it is for 
profit (2) the character of the copyrighted work (3) how much of the total 
work is used and (4) what effect the use will have on the market for or 
value of the work being copied. 



6 Can I use a recognizable part of a photograph if the entire 
source photograph is not recognizable? 
You would have to apply the fair use factors. Obviously, factor (3) in the 
previous answer relating to how much of the total work is used would be in 
your favor, but if the use is to make a profit and will damage the market for 
the source photograph it might be considered an infringement. 

7 What are the damages for infringement? 
The damages are the actual losses of the person infringed plus any profits 
of the infringer. In some cases (especially if the work was registered before 
the infringement), the court can simply award between $500 and $20,000 
for each work infringed. If the infringement is willful, the court can award 
as much as $100,000. 

8 Do I have to register my images to obtain my copyright? 
No, you have the copyright from the moment you create a work. However, 
registration with the Copyright Office costs $20 and will help you in the 
event your work is infringed. To obtain Copyright Application Form VA (for 
Visual Arts), write to the Copyright Office, Library of Congress, Washington, 
D.C. 20559 or call (202) 707-9100. Ask for the free Copyright Information 
Kit for the visual arts and you will receive many helpful circulars developed 
by the Copyright Office. 

9 Do I need to use copyright notice to obtain or protect my 
copyright? 
It is always wise to place copyright notice on your work, because it is a visi­
ble symbol of your rights as copyright owner. Prior to 1989 the absence of 
copyright notice when the images were published or publicly distributed 
could, in certain circumstances, cause the loss of the copyright. Since 
March 1, 1989, the absence of copyright notice cannot cause the loss of the 
copyright but may give infringers a loophole to try and lessen their dam­
ages. Copyright notice has three elements: (1) "Copyright" or "Copr" or "©" 
(2) your name and (3) the year of first publication. 

How do I get permission to reproduce an image? 
A simple permission form will suffice. It should set forth what kind of pro­
ject you are doing, what materials you want to use, what rights you need in 
the material, what credit line and copyright notice will be given, and what 
payment, if any, will be made. The person giving permission should sign 
the permission form. If you are using an image of a person for purposes of 
advertising or trade, you should have them sign a model release. If the per­
son's image is to be altered or placed in a situation that didn't occur, you 
would want the release to cover this. Otherwise you may face a libel or 
invasion of privacy lawsuit. 

Tad Crawford, Esq. is the author of Legal Guide (or the Visual Artist, Business and 
Legal Forms (or Fine Artists, Business and Legal Forms (or Photographers, and other books 

published by Allworth Press, 10 East 23rd Street, New York, NY I 00 I 0. 

0 1995 Tad Crawford 



"Photoshop for Macintosh is a computer education done the right 
way!" 

Photo Lab Management 

"Visual QuickStart Guide: Photoshop 2.5 for the Macintosh is a 
great choice for someone just starting out with Photoshop. In 
under 250 pages, it covers all of Photoshop's fundamental tech­
niques. The book is heavy on illustrations and diagrams, and 
each technique is covered in a straightforward 1-2-3 manner." 

Mac Monitor 
Savannah Macintosh Users Group 

"This book provides a no-nonsense, step-by-step guide to get 
readers up and running in hours rather than days .... The Visual 
QuickStart format allows you to pick up new skills without 
wading through endless pages of text .... With a heavy emphasis 
on graphics, the book includes hundreds of tips to steer begin­
ners out of harm's way." 

I~sNews 2Me 

"The authors describe each command's function clearly and sim­
ply, and pictures accompany throughout to help you understand 
effects achieved. If you've been asked to start using Photoshop 
right now, this book may be your best bet for getting something 
done fast." 

Washington Apple Pi 

Other Visual QuickStart Guides by Elaine Weinmann 

QuarkXPress for Macintosh 
QuarkXPress for Windows 

Other Visual QuickStart Guides by Elaine Weinmann 
and Peter Lourekas 

Illustrator for Macintosh 
Photoshop for Windows 
Painter for Macintosh 
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PHOTOSHOP. 3 FOR MACINTOSH 

Need to learn Photoshop fast? 
Try a Visual QuickStartl 

BOOK LEVEL 

I- /beginning Ill Ill/intermediate 
~~ advanced 

.£,.a._ Takes an easy, visual approach to teaching Photoshop, where 
pictures guide you through the software and show you what to do . 

.£,.a_ Works like a reference book-you look up what you need and 
then get straight to work. 

.£,.a_ No long-winded passages-concise, straightforward commentary 
explains what you need to know. 

Based in New York, Elaine Weinmann is an artist and an instructor 
at the New School Computer Instruction Center and Pratt Manhattan. 
Peter Lourekas is a New York- based artist, a faculty member of 
Parsons School of Design and the New School Computer Instruction 
Center, and an instructor at The Cooper Union School of Art. 

I SBN 1-56609-144-6 
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